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  سریع معرفی

  

  اندازی راه و نصب

ستیار WinOLS.EXE نصب برنامھ شروع ھنگام ست نصب د  روند ادامھ برای این البتھ. کند می را مجوز مجوز تصدیق درخوا

  .است لازم نصب

 این. شود می خواستھ باشد، "C: \ Program files \ EVC \ WinOLS" کھ نصب، فرض پیش مسیر تأیید برای شما این از بعد

  .کرد ذخیره سرور در پوشھ یک در بعدا توان می را ماشین ھای داده. شود استفاده شبکھ یک نصب ھنگام باید نیز یکی

  .شود تأیید »بعدی« دادن فشار با است ممکن نیز بعدی سھ

 قادر شما این بر علاوه. است نشده پشتیبانی ھنوز EPROM افزار سخت یا ساز شبیھ. کند می کار نام ثبت زمان تا افزار نرم این

  .نیستید اطلاعات گونھ ھر ذخیره بھ

 مربوطھ تأیید کادر باید کنید، استفاده MP2440P اپراتور یا OLS16 ساز شبیھ مانند قدیمی ھای دستگاه از خواھید می اگر: توجھ

  .کنید نصب نصب حین در را

  

  WinOLS نام ثبت

 را نامحدود زمان برای کامل افزار نرم این کردن فعال بھ س����یدس����تر حق ش����ما WinOLS برای رس����انی روز بھ مجوز خرید با

  .باشد می شما شرکت اقامت محل در کامپیوتر ده از بیش با افزار نرم این از استفاده حق شامل مجوز. کنید می دریافت

ستف برای شده گرفتھ نظر در افزار نرم این. کنید نصب ھا رایانھ تمام روی را WinOLS لطفا بنابراین ست کدام ھر ثبت و ادها . ا

  .بگیرید تماس ما با کنید، خریداری را WinOLS میخواھید اگر لطفا

  WinOLS شروع ·

  .کنید انتخاب "Miscellaneous" منوی از را "WinOLS ثبت" انتخاب ·

  کنید دنبال را دستیار دستورالعمل ·

  

  زبان

 نخواھند شناسایی دیگر ھای نسخھ تمام. شد خواھد تنظیم خودکار ورط بھ زبان ویندوز انگلیسی یا آلمانی نسخھ از استفاده ھنگام
 <Miscellaneous-Configuration-Miscellaneous-Language" ("Sonstiges" در توان می را زب��ان تنظیم��ات. ش��������د

Config> Sonstiges> Sprache") شود، می اصلاح تنظیمات این کھ ھنگامی. یافت WinOLS کند تغییر بھ شروع دوباره باید.  

  

  ھا چکمھ

  WinOLS از مس�������تقیم طور بھ توان می را ماژول این. داد گس�������ترش کنترلی ھای ماژول با توان می را EVC در آنلاین یا 

evc.de. رسانی روز بھ تابع از سادگی بھ خرید، از پس WinOLS کنید نصب خودکار طور بھ را ھا ماژول تا کنید استفاده.  

  

     شبکھ نصب

 ھر روی بر باید نیز افزار نرم. ش�����د داده توض�����یح بالا در کھ ھمانطور ش�����ود، تنظیم کاری ایس�����تگاه ھر در باید WinOLS اول

  .شود باز جداگانھ کامپیوتر

 ھر WinOLS در باید دایرکتوری این در مسیر ."WinOLS ھای داده" مثال برای کنید، ایجاد سرور در مشترک دایرکتوری یک

-Miscellaneous-Configuration-Paths-EPROM-Data Path" ("Sonstiges-Konfiguration" مسیر در کاری ایستگاه

Pfade-Pfad für Eprom-Daten") شود تنظیم.  
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DLL ھای CheckSum نام بھ دایرکتوری ھر در باید اما نگیرند، قرار مشترک دایرکتوری در است ممکن  

 "C: \ Program Files \ EVC \ WinOLS \ DLLs" شود کپی.  

  

  اصلی صفحھ

  :است عنصر چندین دارای WinOLS اصلی صفحھ

  

  

  

  

  

  

  

  

  

  

  

  

  

  

   

  مشتریان بین سوئیچینگ. ١

  کنید وارد مربوطھ ھای ورودی بھ نمایش کاھش برای متن یک. ھا نقشھ و ھا نسخھ ھا، پروژه برای جستجو زمینھ. ٢

  قبلی جستجوھای برای کشویی دکمھ. ٣

  جستجو و نقشھ لیست ھای گزینھ. ۴

  عناصر بین) سیاه مثلث( سریع سوئیچینگ و دکمھ پروژه خواص. ۵

  است شده داده نشان پائین رنگ) برنامھ کد و خالی محدوده( مھم غیر ھای برنامھ محدوده. ۶

  است کوچک حد از بیش پنجره کھ ھنگامی نوار یا hexdump اولویت تغییر. ٧

  پروژه از رنگی کلی نمای. ٨

  شود می یافت پتانسیل نقشھ خودکار طور بھ. ٩

  )است مشاھده قابل" من ھای نقشھ" در ھمچنین( شما توسط شده ثبت نقشھ. ١٠

  ٣d و ٢d متن، بین مشاھده حالت تعویض. ١١

  متن توضیحات ھا، بلوک سازی ھمگام ھا، پچ ھا، چکمھ: شده چک وضعیت. ١٢

  (OLS300 یا OLS16 ماژول از( افزار سخت وضعیت. ١٣
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  ھا پروژه

 یا ھا اص��لاحیھ از بس��یاری و اص��لی فایل یک ش��امل کھ ،WinOLS توس��ط اص��طلاح بھ ھای پروژه در EPROM ھای داده امتم

 می ذخیره احتمالی نظرات ھمچنین و نقلیھ وس��یلھ ھای داده با ھمراه واحد فایل یک بھ را آنھا. اس��ت نیاز مورد ھس��تند، ھا نس��خھ
  .شود

  :باشید داشتھ توجھ لطفا

 دھد، می قرار شما اختیار در را زیادی اطلاعات WinOLS کھ آنجایی از. ندارد وجود خارجی ھای فرمت مستقیم شویرای امکان

 یا کنید رایت یا( کنید ص�������ادر را آن دوباره و) کردن رھا و کش�������یدن با مثلا( کنید وارد WinOLS پروژه یک بھ را آن باید ابتدا

  ).کنید نوشتن

  :کنید نتخابا را زیر موضوعات از یکی لطفا

  

  پروژه یک ایجاد ·

  فایل یک از ·

  EPROM از ·

  (BDM100 طریق از) ECU از ·

  اصلی ·

  نسخھ ·

  

  

  پروژه یک ایجاد

 می حاض��ر حال در فایل یک از یا EPROM از خارج ھای داده. ش��ود می آغاز »جدید پروژه« انتخاب با جدید پروژه یک ایجاد

  شود خوانده خالی پروژه این بھ تواند

  

  فایل یک زا

. »بیت ١۶ یا ٨ دوتایی« انتخاب با س��پس اس��ت، خواندن حال در »پرونده کردن وارد پرونده« انتخاب با پرونده یک ھای داده   
  .شود انتخاب باید فایل نام سپس

 یک در را فایل اگر. بکش�����ید WinOLS پنجره بھ مس�����تقیم طور بھ را Outlook ھای ایمیل پی اچ پی یا ھا فایل توانید می ش�����ما

 خالی فض���ای کار زمینھ پس در یا WinOLS قاب کادر روی اگر. ش���ود می وارد نس���خھ عنوان بھ کنید، رھا موجود پروژه پنجره

  .شود می وارد جدید پروژه عنوان بھ باشید، افتاده

  

  EPROM یک از

 فرآیند آن از پس ش����ود، خابانت "Hardware-Producer" در ابتدا در باید آن نوع ش����ود، خوانده EPROM کھ ص����ورتی در    

  .شود می آغاز "Hardware-Eprom-Read" انتخاب با خواندن

  

  (BDM100 طریق از) ECU از

. بخوانید BDM100 اضافی افزار سخت با توانید می را) کرد خواھید پیدا EVC سایت وب در لیست یک شما( ھا ECU از بعضی

ند، می را EPROM تنھا نھ این  WinOLS ھا داده این ذخیره برای .(CPU داخلی حافظھ مثلا( موجود تخاطرا تمام بلکھ خوا

  .)است شده داده توضیح" ویژه ھای جنبھ" فصل در عناصر. (کند می ایجاد پروژه در عنصر چندین
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 روند ش����روع برای. کنید مراجعھ EVC س����ایت وب در BDM100 دفترچھ بھ لطفا BDM100 طریق از ECU یک خواندن برای

  .کنید انتخاب را "Hardware-BDM-Read" منوی ی گزینھ ،WinOLS در خواندن

  

  اصلی

 بھ ھا آن از کدام ھر کھ حالی در ش������ود می ذخیره »اص������لی« عنوان بھ خودکار ص������ورت بھ خواندن حال در رکورد اولین    
 بھ فایل ذخیره بھ نیاز ھا چکمھ از بعض�����ی. کرد تعیین بعدا توان می را مختلف ھای نام حال، این با. ش�����ود می نامیده »نس�����خھ«

  .دارند ECU از یافتھ تغییر ھای داده ذخیره برای "Original" عنوان

 بعدا پروژه، برای نقلیھ وسیلھ ھای داده کردن تایپ برای آن در کھ شود می ظاھر گو و گفت پنجره یک اصل، در خواندن از پس
  .شود می شناسایی

  

  نسخھ

 وارد اس��ت ممکن خودرو اطلاعات و نام آن در کھ ش��ود می ظاھر ای محاوره پنجره یک ش��ده، وارد نس��خھ یک کھ ھنگامی     
ست شده اصلاح دیگری افزار نرم توسط کھ بخوانید را فایل یک توانید می ھمچنین شما اینجا در. شود  کھ ای چکمھ برای فقط ا
  .شود متعادل باید

  نسخھ پوشھ ھای

 را آنھا تا کنید اس��تفاده نس��خھ ھای پوش��ھ از توانید می ھمچنین ش��ما اما اس��ت، هش��د ذکر س��ادگی بھ فرض پیش طور بھ ھای نس��خھ
 ھای پوشھ از توانید می شما این بر علاوه. کند خدمت دیگری نسخھ بھ پوشھ یک عنوان بھ تواند می نسخھ ھر. کنید سازماندھی

 بر نسخھ ھای پوشھ. باشد نیز دیگر ھای نسخھ شامل دتوان می کھ کنید استفاده) نسخھ یک نھ اما ھستند، ھا پوشھ فقط کھ( انتزاعی
 درخت یک قالب در پروژه یک در نس�����خھ نمایش برای مفھوم یک فقط آنھا. گذارد نمی تاثیر وجھ ھیچ بھ نس�����خھ محتویات روی

 را س�خھن خواص یا بکش�ید باز نس�خھ گفتگوی در دیگری مکان بھ را نس�خھ یک س�ادگی بھ نس�خھ، ھای پوش�ھ تغییر برای. ھس�تند
  .دھید تغییر را مادر و پدر ھای پوشھ و کنید ویرایش
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  معمول وظایف

  

  جدید پروژه یک ایجاد

 این. شود می ظاھر دستیار یک یا جدید خالی پروژه یک شما تنظیمات بھ بستھ. کنید انتخاب را "Project> New" منو آیتم 

  ببندید را آن لزوم صورت در. کند می توصیف را دستیار بدون روش نمونھ

 برای .eprom از یا فایل یک از یا). است بھترین ھمیشھ اصلی داده( دارید نیاز اطلاعات بھ و دارید خالی پروژه یک شما حالا

  :دارد وجود گزینھ چندین فایل، کردن وارد

  .بکشید خالی پروژه پنجره در کردن رھا و کشیدن با را فایل. ١

 میانبر کلید با کردن وارد یا »کنید وارد پرونده کردن وارد> صادرات و واردات> پروژه« منوی آیتم از هاستفاد با را فایل. ٢
Ctrl + I روی کنید، انتخاب را خود فایل فرمت. کنید وارد را«»  نماد یا "Ok" کنید انتخاب را فایل و کنید کلیک.  

 می مقایس���ھ اص���ل با خودکار طور بھ ش���وند، می وارد یا و کنید می دایجا بعدا کھ ھایی نس���خھ تمام اید کرده وارد را اص���لی حالا
 در کھ را بالا مراحل فقط کنید، وارد را نس��خھ یک خواھید می اگر. ش��ود می مش��خص نمایش ص��فحھ روی بر ھا تفاوت و ش��وند

  .کنید تکرار شده داده نشان بالا

  

  کنید پیدا را ھا نقشھ خودکار صورت بھ

. کند می آغاز را ھا نقش��ھ برای جس��تجو ثانیھ چند از پس خودکار طور بھ WinOLS اید، کرده ایجاد دیدج پروژه یک ش��ما اگر    

 بر »جستجو« منوی در منو ھای آیتم جستجوی با توانید می شما. ببینید پنجره انتھای در وضعیت نوار در را این توانید می شما
  .کنید نفوذ زمینھ پس نقشھ جستجوی روی

  :دارد وجود آن نتایج بررسی برای امکان چندین نقشھ، ستجویج پایان از پس

 نقش��ھ تمام ش��امل این. دارد وجود پنجره چپ س��مت در نقش��ھ لیس��ت و پروژه در" بالقوه ھای نقش��ھ" برچس��ب با جدید پوش��ھ یک ·
 روی بر. کنید ازب ماوس چپ س��مت دکمھ از اس��تفاده با آن روی بر کلیک با را پوش��ھ. ش��د یافت جس��تجو طول در کھ اس��ت ھایی
 طور بھ شما ،("P" کلید( است باز پنجره نمایش پیش اگر. کنید مشاھده hexdump در را آن تا کنید کلیک پوشھ این در نقشھ یک

  .کرد خواھید مشاھده را بالقوه نقشھ از ٣D نمایش پیش یک مستقیم

 را آن و کنید استفاده نقشھ از) قبلی برای «Shift + F« یا( بعدی بھ رفتن برای («F« کلید) View> Recognize map تابع از ·

  .کنید انتخاب

 نقشھ تا کنید کلیک برچسب روی بر. است آن نام با کوچک برچسب دارای است شده شناسایی خودکار طور بھ کھ ای نقشھ ھر ·
 برای. کنید تبدیل) ش��ود تر س��اده اندتو می کھ( معمولی نقش��ھ یک در را بالقوه نقش��ھ تا کنید کلیک دوبار نقش��ھ روی. کنید بھینھ را

  .کنید کلیک برچسب روی موس راست کلیک با بیشتر ھای گزینھ انتخاب

  

  )متن حالت( ھا نقشھ دستیابی

. باش��د بھترین دارید دوس��ت کھ نمایش حالت با باید ابتدا. دارد ھا نقش��ھ دس��تیابی برای زیادی مھارت بھ نیاز و نیس��ت آس��ان این  
 اس��تفاده "Shift + F" و "T" میانبر ھای کلید از یا کنید کلیک ص��فحھ پایین قس��مت در "Text> 2d> 3d" زبانھ روی بر این برای

  .کنید

  .است زیر بخش در ٢d حالت برای متناظر توصیف. کند می توصیف متن حالت در را ھا نقشھ دستیابی جستجوی بخش این

 انتخاب را...)  بیتی ١۶ بیتی، ٨( »ارزش����ھا« و کنید کلیک پنجره روی رب کلیک دوبار. کنید انتخاب را نمایش پارامترھای حالا
 پردازنده و کنند می اس����تفاده HiLo نماد از موتورولا ھای پردازنده. کند می اس����تفاده بیتی ١۶ ھای داده از اغلب جدید ECU. کنید

 در را آن توانید می ش�ما. کند می ش�ناس�ایی را پردازنده س�ازنده خودکار طور بھ WinOLS. (کنند می اس�تفاده LoHi از اینتل ھای

  .)کنید انتخاب را "Project> Properties: Project. "کنید مشاھده پروژه خواص

  :نکتھ چند. کنید استفاده کلید یا) پیمایش نوار یا موس چرخ( ماوس از. رفتھ فایل طریق از حاضر حال در
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. بگیرید نادیده را منطقھ این باید شما. شود می شناختھ WinOLS توسط برنامھ کد عنوان بھ منطقھ این باشد، رنگ کم اعداد اگر ·

. ش���ود خودرو افزار نرم نابودی باعث راحتی بھ اس���ت ممکن تغییرات و کنید نمی پیدا اینجا در را ھا نقش���ھ ش���ما معمول طور بھ
  .ھستند علاقھ بی اندازه ھمان بھ و شوند می داده نمایش نیز خالی مناطق

 این توانید می ش��ما. بیابید را پروژه نادرس��ت مش��ی خط تا کنید اس��تفاده) »کلی نمای پنجره« منوی آیتم( مرورگر پنجره یک از ·

 این ،X دکمھ چپ س����مت دکمھ روی کلیک با میتوانید ھمچنین. نمایش پیش پنجره مثل درس����ت دھید، تغییر و دھید تغییر را پنجره

  .کنید »کردن رول« را پنجره

شھ این برای را نمایش تنظیمات کھ اس�ت این دھید انجام باید کھ کاری اولین باش�د، نقش�ھ یک تواند می کھ کردید پیدا یچیز اگر  نق
 ھا س��تون تعداد با. اس��ت متن حالت ترین س��اده اما دھید، انجام مش��اھده ھای حالت تمام در را کار این توانید می ش��ما. دھید تطبیق
 تغییر ای گونھ بھ را ھا س��تون تعداد. دھند می نش��ان نقش��ھ در را جدیدی خط کھ دارند ھایی جھش اغلب ھا نقش��ھ این. کنید ش��روع

. دھید تغییر "W" و "M" میانبر ھای کلید با را ھا س��تون تعداد توانید می ش��ما. دارند قرار س��تون ھمان در ھا جھش تمام کھ دھید

  .بکشید را آن و دھید تغییر را آن تنھا عمودی خط در و نکرد کلیک با توانید می ھمچنین شما" متن" نمایش حالت در

  

  

  

  

  

  

  

  

  

  

  

  کلومترھا تعداد تغییر از قبل نقشھ

  

  

  

  

  

  

  

  

  

  

   

  

  کلومترھا تعداد تغییر از پس نقشھ
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 زا تا دھید حرکت را نقش���ھ اولیھ آدرس کھ اینس���ت دھید انجام باید کھ بعدی چیز. ش���ناس���ید می را نقش���ھ از کمی احتمالا ش���ما حالا
 "View> Move right origin" و View> Move origin left منوی آیتم از استفاده این برای. شود شروع ھگزادیم چپ سمت

  .کنید انتخاب را نقشھ شد، تمام کار این با اگر (.Hotkeys Ctrl + Cursor left or right. (کنید کلیک

 را نقش����ھ اگر. کنید س����ازی بھینھ را خود ھای داده ارزش محدوده باید ش����ما نباش����د، مفید چیزی نوار ص����فحھ اگر: کوچک نکتھ(  
 خودکار طور بھ WinOLS. دھید فش����ار را Ctrl + B یا کنید انتخاب را ارزش دامنھ س����ازی بھینھ »مش����اھده« اید، کرده انتخاب

  .)میلھ برای ودموج heigts از استفاده مطلوب طور بھ انتخاب در استفاده مورد ھا داده کھ طوری بھ شده پیکربندی

  

  

  

  

  

  

  

  

  

  درست شروع با نقشھ

  

  

  

  

  

  

  

  

  

   

  است شده گذاری علامت نقشھ

  

ید می اکنون اید، ش�������ده فعال نمایش پیش پنجره اگر   ید را خود انتخاب از بعدی س�������ھ نمایش پیش یک توان نھ از. ببین  منو گزی
 و ش��ود می باز جدید پنجره یک. کنید اس��تفاده خود تخابان از نقش��ھ یک ایجاد برای را (" K" کلید"( نقش��ھ> - انتخاب"> انتخاب"

  .کنید ویرایش را خود نقشھ توانید می شما

  :نقشھ بھ ورود برای گزینھ چند ابتدا اما

شھ انتخاب" دستیار · شتیبانی نق شتیبانی"> "مشاھده" منوی آیتم با را آن. کند کمک شما بھ تواند می" پ شھ پ . کنید فعال" انتخاب نق
 آن کردن فعال بدون دس�تیار حالت این در. بودید فعال انتخاب این انجام حین در ش�ما آنکھ جز بھ( افتاد نخواھد اتفاقی ھیچ ابتدا در
 این. کند س��ازی بھینھ را آن کرد خواھد س��عی خود دس��تیار کنید، می انتخاب را موس اکنون اگر). ش��د خواھد اعمال دائم طور بھ

 مراقب باید ھمیش���ھ اما. دھیم می انجام خودکار ص���ورت بھ...)  ش���روع، ھا، س���تون تعداد( دادیم توض���یح بالا در ما کھ را مراحل
  .کنید انتخاب ندارید تعلق نقشھ بھ کھ را اطلاعاتی کھ باشید
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 دنما"> مش��اھده" منوی آیتم انتخاب با را گزینھ این باش��د لازم اس��ت ممکن. کند می کار" نقش��ھ انتخاب" با کامل طور بھ دس��تیار ·
 تغییر جدید نماد نوار با بعدا توانید می کنید، می ایجاد مس���تطیلی انتخاب یک ش���ما گاه ھر. کنید فعال ،" نقش���ھ انتخاب: قاب> میلھ
  .دھید تغییر را ستون یا ردیف تعدادی یا دھید تغییر Y یا X جھت در را شروع توانید می شما. دھید

  

  ) 2d حالت( کنید پیدا را ھا نقشھ دستی

 (HiLo، LoHi... /  بیت، ١۶ بیت، ٨( نمای پارامترھای تنظیم با. است متن در آن یافتن بھ شبیھ ٢d حالت در ھا نقشھ کردن پیدا

 کھ باشید داشتھ یاد بھ. (کنید پیدا احتمالی ی نقشھ تا کنید حرکت فایل طریق از سپس و کنید شروع شد، گفتھ بالا در کھ ھمانطور
  .)دھید تغییر "Frame: View" منو نوار با را Y و X زوم فاکتورھای توانید می

 عمودی خطوط" خطا ھای خط" ٢d حالت در. کنید شروع ھا ستون مناسب تعداد تنظیم با باید اید، کرده پیدا را احتمالی نقشھ اگر

  .کنید پیکربندی (٢d محدوده در نمایش صفحھ( تنظیمات در را این توانید می شما اما ھستند، نماد

شھ در" جھش" با ھمواره عمودی خطوط کھ طوری بھ دھید تغییر را ھا ستون دتعدا  و "M" میانبر ھای کلید از. ھستند موازی نق

"W" کنید استفاده ستونھا حذف یا کردن اضافھ برای.  

  

  

  

  

  

  

  ستونھا تعداد تغییر از قبل نقشھ

  

  

  

  

   

  

  ستونھا تعداد تغییر از پس نقشھ

 انتخاب حق حرکت"> مش��اھده" و" چپ س��مت بھ حرکت" / "نمایش(" دھید حرکت را نقش��ھ ابتدا ایدب ھمچنین ش��ما d٢ حالت در  

 این با اس��ت، درس��ت س��تونھا تعداد کھ کند روش��ن اس��ت ممکن این). راس��ت یا چپ س��مت نما مکان + Ctrl میانبر ھای کلید با یا"

  .شود داده نشان بالا مراحل بھ مورد این در. حال

  

   

  

  

  

  

  درست روعش با نقشھ
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  است شده گذاری علامت نقشھ

 زدن مارک با. ھس��تند دیگری بھ نزدیک کاملا پیکس��لھا زیرا نیس��ت، آس��ان ٢d حالت در کھ کنید، انتخاب را نقش��ھ باید ش��ما حالا  

 یک ھب کند می اشاره فلش یک بھ نما مکان. انتخاب چپ سمت از بیش روی ماوس حرکت حاضر حال در. است خشن تنھا نقشھ
 می تغییر ش���ده س���اختھ قبلا کھ را انتخابی تنھا نھ این. بکش���ید راس���ت یا چپ بھ و کنید کلیک را اینجا گزینھ این تغییر برای. خط
 انتھای برای را این. ش���ود می ش���روع خط یک روی بر انتخاب کھ کرد خواھد حاص���ل اطمینان خودکار طور بھ WinOLS. دھد

  .کنید تکرار انتخاب راست سمت

 بھ را آن توانید می کنید، فعال دائم طور بھ را آن خواھید نمی اگر. اس����ت تر آس����ان" انتخاب نقش����ھ پش����تیبانی" دس����تیار با ھم، زبا
  )کرد خواھد کار متن حالت در نیز کار این البتھ: (کنید انتخاب را موس راست کلیک با فقط. کنید درخواست درخواست صورت
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  نمایش پیش

 خودکار طور بھ نیست، تر گسترده ستون ٣٢ از کھ دارید مستطیلی انتخاب یک شما اگر اید، کرده فعال را نمایش پیش پنجره اگر
 برای. بخوانید را پنجره چگونھ کھ بگیرید یاد باید ش���ما اما اس���ت، مفید بس���یار ش���ما ھای نقش���ھ تنظیمات برای این. ش���د خواھد باز

  .دارد وجود معمول نظر چند شما، بھ کمک

  

 بقیھ از" بالاتر" خیلی کھ آنجایی از. نیست متعلق نقشھ بھ و است متفاوت رسد می نظر بھ بالا سطح است شده انتخاب حد از بیش
  :است دشوار بسیار تشخیص بنابراین و شود می داده نمایش کوچکتر بقیھ است،

  

  

  

  

  

  

  

  

   

  .جھش توسط رفتھگ شکل معمول عمودی خط بھ نگاھی اشتباه ستون تعداد

  

  

  

  

  

  

  .دارد وجود نقشھ در" پرش" یک. است اشتباه شروع اما راست، ھای ستون تعداد

  

  

  

  

  

  

  

  :درستھ چی ھمھ
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  نقشھ تغییر

 نقشھ یک در ویرایش اما کنید، ویرایش hexdump در مستقیما را ھا داده توانید می شما مطمئنا، شود؟ می استفاده ھا نقشھ چرا

  :است ردم مزایای دارای

  .کند می پیدا دوباره را ھا نقشھ دیگر بار و آورد می ارمغان بھ پروژه یک در را ساختار این ·

  .کنید باز زمان ھمان در را پنجره چند توانید می شما ·

  .شوند انجام افزایشی محاسبھ با اگر حتی میشوند، داده نمایش صحیح محور مقادیر ·

  .دھید تغییر را نقشھ از خارج لاعاتاط شانسی صورت بھ نمیتوانید شما ·

-" و"+"  کلید کھ است این راه ترین ساده. دھید تغییر را آن خواھید می اکنون و اید داده توضیح بالا ھای روش با نقشھ یک شما
. شود انجام یعترسر و سریعتر تغییر تا دھید فشار را کلید. کنید استفاده نما مکان فعلی مکان در مقدار کاھش یا افزایش برای را" 

  .کنید استفاده (Hotkey F11( »اصلی مقدار> ویرایش« منوی آیتم از سپس بازگردید، اولیھ مقدار بھ خواھید می اگر

 تغییر را شده ایجاد ھای انتخاب راه توانید می ھمچنین شما: حال ھر بھ. شود می انتخاب کل در اید، کرده ایجاد انتخابی اگر
 شما اما. دارد می نگھ") دل" کلید یا و" چیز ھیچ انتخاب" انتخاب( حذف را آن شما کھ زمانی تا تخابان معمول طور بھ. دھید

 کلیک یک کھ طوری بھ کنید، پیکربندی را (F12 یا "Miscellaneous> Configuration") WinOLS توانید می ھمچنین

  .دکن می حذف "Miscellaneous" صفحھ روی بر را قبلی انتخاب ھمیشھ موس

. است شده انتخاب مقادیر تغییر برای دیگر ابزار چندین کھ دید خواھید منو یک انتخاب، بھ راست کلیک با راست کلیک با اگر

 Enter کلید دوباره و کنید وارد جدید مقدار یک کنید، وارد Enter کلید سادگی بھ: شود ذکر باید ساده بسیار روش یک نھایت در

  .دھید فشار را

  

  لیدھاک کردن چک

 بھ باید اینھا. شود می انجام اضافی ھای افزونھ توسط اغلب این زیرا است، آسان بسیار است درست کردن چک کردن چک
  .شود می انجام شود، می انجام خودکار صورت بھ کھ کارھایی ھمھ نیز کار این برای اما شوند، خریداری جداگانھ صورت

 روی. کنید وارد "Start" علامت با را ای محاوره کادر ،(F2 فوری یدکل) Edit> Checksum گزینھ روی بر کلیک با

 محاسبھ کنی چک و شود می اعمال خودکار طور بھ را آن باشید، داشتھ درست کنترلی ماژول مالک اگر. کنید کلیک" جستجو"
  .شود اصلاح ھمیشھ) خواھید می را آن شما اگر( و شود می

 روی. کنید بررسی را پروژه تعھدی، گونھ ھیچ بدون و رایگان صورت بھ EVC از نیدتوا می ندارید، را تطبیق ماژول اگر

 چند. شود می ارسال) نیاز مورد اینترنت بھ اتصال) EVC سرور بھ و فشرده پروژه این. کنید کلیک" آنلاین چکمھ در جستجو"

  .میکند کار شما ھھایداد برای کنترلی ماژول میگوید کھ کرد خواھید دریافت پاسخ یک شما بعد ثانیھ

 را اصلی ھای داده باید شما کھ است معنی این بھ. دارند نشده اصلاح اصلی نسخھ یک بھ نیاز کلماتی ھای ماژول از برخی: مھم
 بھ کل کلمۀ کھ بیفتد اتفاق است ممکن صورت این غیر در. کنید بارگیری WinOLS پروژه بھ اصلی نسخھ عنوان بھ ماشین از

  .است نشده محاسبھ یا نشده محاسبھ درستی

  

  تر قدیمی ھای پروژه از شده وارد ھای داده

 WinOLS. بسازید مجددا را چرخ کھ ندارد وجود دلیلی ھیچ است، قدیمی سالھ یک بھ شبیھ کھ دارید جدید پروژه یک شما اگر

 تغییرات بھ ھم و ھا نقشھ مانند اطلاعات ساختن برای ھم امر این. است ھا داده کردن وارد برای بسیاری ھای ویژگی دارای
  .شود می اعمال بخصوصی
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 WinOLS دھد می ارائھ را زیر ھای ویژگی:  

  تغییرات واردات ·

  کنید وصل را ھا پنجره+  مرجع نسخھ ·

  نقشھ کردن وارد ·

  نقشھ ھای بستھ ·

  ھا اسکریپت ·

  

  شده وارد تغییرات

 و -Ex> پروژه> منو آیتم. است فعلی پروژه بھ شده باز دیگر، پروژه یک از ھا داده کردن وارد برای امکان ترین ساده این

Import> Import changes کنید انتخاب را )Hotkey Ctrl + Alt + I). اتوماتیک حالت در WinOLS نقشھ خودکار طور بھ 

 می آماده اتصال و مرجع با را پنجره دو ای کتابچھ حالت. دھد می تشخیص کند می جستجو جاری پروژه در را آنھا کھ را ھایی
  .کند

  

  کنید وصل را ھا پنجره+  مرجع نسخھ

 اما باشد، قدرتمند بسیار آن کھ شود می باعث این. کنید وارد دستی صورت بھ را ھا داده دھد می اجازه شما بھ ھا حالت این
 منوی ھای آیتم با دستی صورت بھ را اھ حالت این توانید می شما. بالا در شده داده توضیح دستیار از است، دشوار ھمچنین

 از پس. شد داده توضیح بالا در کھ ھمانطور کند، پیکربندی شما برای را آنھا WinOLS دھید اجازه یا کنید فعال «View منوی«

. کرد خواھد حرکت نیز دیگر کنید، اسکرول را پروژه یک شما اگر. داشت خواھید دیگری کنار در را پروژه دو ھر شما آن
 برای اصلی نسخھ عنوان بھ آن ھای داده کھ معنی این بھ بود، خواھد" مرجع نسخھ" ھمیشھ دیگر پنجره تر، آسان مقایسھ برای
 در نقشھ یا انتخاب یک روی بر راست کلیک با). نباشید نگران موقت، فقط( گیرند می قرار استفاده مورد فعلی پنجره

hexdump دھید انتقال را") نقشھ انتقال" یا" انتقال رزشا" منو آیتم( داده توانید می شما  

  

  ھا نقشھ کردن وارد

 یک از نقشھ اطلاعات کردن وارد برای منو آیتم این از توانید می دارند، قرار آدرس یک در ھا نقشھ تمام کھ ھستید مطمئن اگر
 مھم ھا نقشھ در موجود ھای داده. بود خواھد...)  اندازه، آدرس،( ساختاری اطلاعات انتقال تنھا این. کنید استفاده دیگر پروژه
  .بود نخواھد

  

  نقشھ ھای بستھ

 از ھا نقشھ صادرات با باید شما اما. دھند انتقال را نقشھ ھای داده توانند می نقشھ ھای بستھ شد، اشاره بالا در کھ ھمانطور
 بسیار ھا فایل این. دارد متعددی مزایای این. شوید جدید پروژه وارد بعدا تا کنید شروع نقشھ بستھ فایل یک بھ قدیمی ھای پروژه

 تر آسان را آنھا انتقال امر این. ندارند ای نقشھ ارزش ھیچ دارند، ساختاری اطلاعات فقط زیرا ھستند پروژه ھای پرونده از کم
  .کنید وارد خسارت جبران کردن وارد ھنگام در توانید می شما این بر علاوه. کند می

  

  ھا اسکریپت

 ”Project > Ex- and Import > Scripts ( ھا اسکریپت از استفاده با. شد ساختھ قدرت کاربران برای WinOLS برای گزینھ نای

or Hotkey F8 (یا Hotkey F8) این. کنید صادر خاص اسکریپت ھای فایل در را ھا نقشھ مقادیر یا/  و ساختار توانید می شما 

 واقع شود، اصلاح باید کھ نقشھ، موقعیت، کدام در و کرد اعمال را آنھا توان می آیا کھ ھندد می تشخیص خودکار طور بھ ھا فایل
 برای مشابھ تغییر بھ مجبور شما اگر ھا اسکریپت از استفاده. درصد یا و تفاوت عنوان بھ مطلق، توان می را تغییرات. است شده

  .ھستید ھا فایل از بسیاری
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  ویژه ھای جنبھ

  کلید صفحھ میانبرھای

WinOLS در و کشویی منوی در تابع کنار در مستقیما آنھا اکثر. کند می پشتیبانی توابع از بسیاری برای میانبر ھای کلید از 

Tooltip اند نشده ذکر لیست در زیر میانبر ھای کلید. ھستند مستند آن آیکون:  

  

    

  

  ناوبری+  نما مکان

  

  قفل اسکرول

  .کنید حرکت ماوس چپ سمت دکمھ با hexdumps طریق از توانید می راحتی بھ حالت این در اسکرول حالت تغییر 

    

  

    

    

Ctrl + بالا  

  برد می بالا را رویت قابل منطقھ 

    

Ctrl + پایین  

  دھد می حرکت را پایین رویت قابل منطقھ 

    

  

    

    

Ctrl + بالا  

  برد می پنجره ابتدای بھ را نما مکان 

    

Ctrl + End 

  دھد می حرکت پنجره نتھایا بھ را نما مکان 
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Shift + Cursorkeys 

  کند می انتخاب حرکت حین در و دھد می حرکت را نما مکان 

    

Ctrl + Cursor l / r 

  دھد می حرکت را hexdump یک شروع آدرس 

    

Ctrl + Shift + Cursor l / r 

  (٣d حالت فقط( چرخاند می را نمایش 

    

  

    

    

T 

  )متن <- ٢d ؛٣d -> 2d( قبلی مشاھده حالت 

    

Shift + T 

  (٢d -> 3d ؛٢d> - متن( بعدی مشاھده حالت 

    

  

    

    

Ctrl + صفحھ  

  )تنظیم قابل پرش اندازه با( بالا صفحھ 

    

Ctrl + PageDown 

  )تنظیم قابل پرش اندازه با( پایین صفحھ 

    

  

    

  

    

  

  Alt، Shift، Ctrl با ویژه موارد
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Shift شروع ھنگام در OLS  

 WinOLS شود می باز قبلی ھای پنجره بارگذاری بدون.  

 Ctrl شروع ھنگام در OLS  

  شود نمی استفاده/  اولیھ صورت بھ ساز شبیھ وضعیت نمایش 

 Shift + Mousewheel 

  کند می عبور صفحات از خطوط جای بھ 

 Shift نقشھ یک ایجاد ھنگام در  

  شود می سرکوب خودکار نقشھ تشخیص 

 Strg + Mousewheel 

  zoomfactor / fontsize تنظیم 

 Ctrl + Shift + Mousewheel 

  کند می حرکت یافتھ تغییر ھای سلول روی بر نما مکان 

  ماوس توابع 

  چپ کلیک

  کند می تنظیم را نما مکان موقعیت 

  کنید کلیک کشیدن+  روی: چپ 

  کند می انتخاب را منطقھ یک 

  کنید کلیک Ctrl+  کشیدن+  روی: چپ 

  دھد می گسترش دیگر منطقھ یک با را علیف انتخاب 

  کنید کلیک دوبار: چپ 

  شود می باز 'Properties: Window' منوی 

  متن hexdump در آدرس ستون روی بر کلیک دوبار: چپ 

  کند می باز را" آدرس بھ رفتن" منوی 

  Mousewheel+  کنید کلیک: میانھ 

  دھد می تغییر را انتخاب انتخاب، در نما مکان موقعیت بھ بستھ 

 Middle: کنید کلیک  +Mousewheel + Shift  

  تر قوی اما بالا، در کھ ھمانطور 

  راست کلیک 

  کند می باز را زمینھ منوی 
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  انداختن و کشیدن

WinOLS برنامھ پنجره بھ را پرونده سادگی بھ توانید می شما. کند می پشتیبانی کردن رھا و کشیدن از WinOLS را آن و بکشید 

  .بکشید Outlook در شده ذخیره ایمیل از پیوست یک یا اکسپلورر ویندوز از فایل یک توانید می شما. بکشید آنجا رد

  .بکشید WinOLS بھ زمان یک در را فایل یک توانید می فقط شما معمول طور بھ

  :شوند می پشتیبانی زیر ھای فایل انواع

  دودویی ھای فایل ·

  WinOLS (* .dat / * .ols) و OLS ھای فایل ·

· Map-Pack-Files (* .kp) 

  (blk(* . فایل انتخاب ·

  (hex* . اغلب( اینتل ھفتگی hex ھای فایل ·

  (s19* . اغلب( موتورولا ھگزا ھای فایل ·

  (scr(* . کلیدی ھای فایل ·

  SPI (* .spikey) کلیدی ھای فایل ·

  INI (* .ini) ھای فایل / ifo (* .ifo) ھای فایل ·

  vSpire (* .vSpire) ھای فایل ·

  :شوند می پشتیبانی ھا افزونھ توسط زیر ھای فایل انواع

· Files Vads Vads (* .vbfپلاگین ؛ Import / Export VBF Vadis نیاز مورد(  

  )نیاز مورد خارجی کنترل پلاگین ؛LUA script (* .lua فایلھای ·

  )است نیاز مورد Damos پلاگین ؛a2l* . معمولا) ASAP2 فایلھای ·

  )است نیاز مورد Damos پلاگین ؛dam* . اغلب) Damos فایلھای ·

 rar* . یا zip* . عنوان بھ( سازی فشرده ھنگام توانند می (ASAP2 و Damos ھای فایل استثنای بھ( فایل ھای فرمت این تمامی

  .بکشید WinOLS بھ را بایگانی فایل سادگی بھ. شوند وارد) فایل

  :دارد وجود ترفند چند

  .شود ایجاد موجود پروژه یک برای جدید نسخھ یک تا بکشید موجود پروژه پنجره یک بھ را فایل 
  ).منو نوار ناحیھ در مثال عنوان بھ( بکشید برنامھ خود بھ را فایل فایل، این برای جدید پروژه یک ایجاد برای 

 کردن رھا ھنگام در را CTRL کلید توانید می ید،بکش موجود پروژه یک در را ھگز موتور یا Intel پرونده یک شما اگر 

  .نوشت فعلی نسخھ در را اطلاعات اما کند، ایجاد جدید نسخھ یک نتواند WinOLS شود می باعث این. دھید فشار فایل

 خودکار طور بھ WinOLS. کنید رھا و بکشید ھمزمان بطور را فایل دو توانید می فایل دو در بیت ١۶ کردن وارد ھنگام 

  .است کم و مقدار چھ کھ شود متوجھ تا کرد خواھد عیس

  .شوند منتقل موجود ھای پروژه بھ توانند می فقط Damos فایلھای 

  .پروژه تغییر پروژه، بھ آن کشیدن پیکربندی، تغییر کاری فضای بھ کلیدی فایل یک کشیدن 

 دکمھ داشتن نگھ با( را نما مکان سادگی بھ است، پنھان (WinOLS( ھدف پنجره) شدن رھا و کشیدن فرآیند حین در( اگر 

 دکمھ بمانید منتظر و دھید حرکت) صفحھ پایین مرز( وظیفھ نوار در WinOLS ورودی روی بر) دھید فشار موشواره

  .آورد می ارمغان بھ زمینھ پیش در را WinOLS پنجره پنجره این ماوس

  شناور گفتگوی

WinOLS شناور) "اصطلاح بھ( چندین پشتیبانی "dialogs. معمولی کاری فضای بالای در کھ است ای محاوره ھای پنجره این 

 است باز پنجره اگر حتی کنید کار معمول طور بھ WinOLS با توانید می شما کھ است معنی بدان این. است شده مسدود آن بدون
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 و است باز جستجو پنجره کھ وقتی ثالم برای دھد می اجازه شما بھ این. دارد قرار کاری فضای بالای در) رسد می نظر بھ( و
  .کند می کار دھد می نشان را آن نتایج

 ممکن شما یا. دھید تغییر) مربوطھ منو ھای آیتم و ھا آیکون میانبر، ھای کلید با( جداگانھ طور بھ را ھا محاوره این توانید می شما
  .کنید استفاده شود می دیده حاضر حال در کھ ھایی پنجره ھمھ تغییر برای (Q کلید چپ سمت( تب کلید از است

 ھای پنجره با مقایسھ در را) شود می داده نمایش پنجره نام کھ آبی نوار( آن کوچکتر عنوان نوار با است ممکن شناور گفتگوی 
  .دھد تشخیص معمول

 بھ نزدیک و دھید حرکت را پنجره شما اگر کھ است معنی این بھ این. ھستند" مغناطیسی" شناور ھای پنجره تمام حال، ھر بھ
  .کند پشتیبانی" خوب" موقعیت از تا برد خواھد آنجا بھ دقیقا را آن شوید، نزدیک نمایش صفحھ حاشیھ یا دیگری پنجره

  :شوند می شناور زیر ھای پنجره

 اجمالی بررسی  
 تفاوت  
 نقشھ انتخاب  
 نمایش پیش  
 متن/  بایت دنبالھ برای جستجو  

 شده وصل) راست یا چپ سمت یا( پنجره سمت بھ اگر. باشد ھا حالت بھ تواند می زیرا ست،ا خاص پنجره یک" نقشھ انتخاب"
 کلیک بار دو با را (docked / floating( حالت دو بین توانید می شما. نکنید مشاھده شناور پنجره یک عنوان بھ را آن است،

  .دھید تغییر آن عنوان روی بر کردن
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  اوسم نما مکان

WinOLS انجام ماوس چپ سمت دکمھ از کلیک یک با حاضر حال در کھ آنچھ مورد در اطلاعاتی نمایش برای ماوس نشانگر از 

  .کند می استفاده شود می

  ).فرض پیش نما مکان از غیر بھ( شود می استفاده زیر ماوس ھای مکان

  ':متن' نمایش حالت

. دھید حرکت) آدرس ستون راست سمت) hexdump خط دو روی را ماوس کھ ودش می ظاھر ھنگامی نما مکان این          

  .بکشید و کنید کلیک آن روی عمودی، صورت بھ مشاھده قابل منطقھ حرکت برای

 می ظاھر دھید، می حرکت (bar و hexdump بین) hexdump یک تنھا خط روی را ماوس کھ ھنگامی نما مکان این       

  .بکشید و کنید کلیک روی ستونھا دتعدا تغییر برای. شود

  :' 2d' نمایش حالت 

 قابل سطح تا بکشید و کنید کلیک. شود می ظاھر کنید می حرکت تر پایین مقیاس روی را موس کھ ھنگامی نما مکان این        
  .دھید حرکت افقی طور بھ را مشاھده

 قابل منطقھ حرکت برای. شود می ظاھر دھید می حرکت راست سمت مقیاس روی را موس کھ ھنگامی نما مکان این        
  .بکشید و کنید کلیک آن روی عمودی، صورت بھ مشاھده

 روی انتخاب، یک شروع برای. دھید قرار انتخاب چپ سمت انتھای در را ماوس کھ شود می ظاھر زمانی نما مکان این       
  .بکشید و کنید کلیک

 تا بکشید و کنید کلیک. دھید قرار انتخاب یک راست سمت انتھای در را ماوس کھ شود می رظاھ ھنگامی نما مکان این       
  .دھید حرکت را انتخاب انتھای

 ستونھا تعداد تغییر برای. دھید قرار انتخاب یک در مارک ردیف یک روی را ماوس کھ شود می ظاھر زمانی نما مکان این       
  .بکشید و کنید کلیک روی

 انتقال برای. دھید قرار انتخاب یک در ردیف مارک یک از خارج در را ماوس کھ شود می ظاھر ھنگامی نما مکان نای      
  .بکشید و کنید کلیک روی) ردیفکنندگان ترتیب این بھ و( شروع آدرس

 نما مکان توسط اکنون ھم کھ دھد می قرار ٢d مقدار یک روی بر مستقیم طور بھ را ماوس نما مکان کھ ھنگامی نشانگر این      

 می شما. بکشید و کنید کلیک شده انتخاب مقادیر تمام/  ارزش تغییر برای. است انتخاب از بخشی یا است شده انتخاب ویرایش

  .کنید فعال غیر "٢d" زیر در پیکربندی در را تابع این توانید

    

 :' 3d' نمایش حالت

 تغییر برای. شود می ظاھر دھید می قرار طبقھ شبکھ راست یا چپ سمت لبھ روی را موس شما کھ ھنگامی نما مکان این      
  .بکشید و کنید کلیک انداز چشم قدرت

    

 کلیک نمایش چرخاندن برای. دھید می قرار کف شبکھ تر پایین لبھ روی را ماوس کھ شود می ظاھر زمانی نما مکان این        
  .بکشید و کنید

    

 حاضر حال در کھ دھید قرار ٣d مقدار یک روی بر مستقیم طور بھ را ماوس نما مکان کھ شود می ظاھر یزمان نشانگر این        

/  ارزش تغییر برای. دھید می قرار انتخاب یک روی را ماوس کھ ھنگامی یا است شده انتخاب ویرایشگر نما مکان از استفاده با
  .کنید فعال غیر "٣d" تحت پیکربندی در را تابع این وانیدت می شما. بکشید و کنید کلیک شده انتخاب مقادیر تمام
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  زمینھ منوھای

 منوھا این. شوند می ظاھر پنجره در جایی در ماوس راست سمت دکمھ روی کلیک ھنگام کھ ھستند منوھا ھمھ زمینھ منوھای
  ).کنید کلیک شما آن در کھ معنی بھ( فعلی متن بھ مربوط کھ است توابع شامل

 را ماوس کھ ھنگامی ،)دھند می نشان را صفحھ پایین لبھ( وضعیت نوار در راھنما متدھای نمایش زمینھ منوی در ھا نوشتھ ھمھ
  .دھید می حرکت مربوطھ ورودی یک روی

  

  .شود می استفاده WinOLS توسط زیر زمینھ منوھای

  :مشاھده حالتھای ھمھ

  .شود می ظاھر ناوبری و ویرایش برای تابع با زمینھ منوی: کنید کلیک ھا داده در

  .شود می ظاھر زمینھ متن ویرایش و انتخاب یک تغییر برای تابع با زمینھ منوی یک: کنید کلیک شده انتخاب ھای داده در

  

  .شود می ظاھر راست سمت نمایش حالت تغییر برای تابع با زمینھ منوی: نوار یا ASCII داده روی بر کلیک با

  

  2d' ' و' متن' نمایش حالت

  .شود می ظاھر بالقوه ھای نقشھ با کار برای تابع با زمینھ منوی یک: کنید کلیک بالقوه نقشھ یک تگ روی

  

  ':متن' نمایش حالت

  .شود می ظاھر ھا ستون تعداد تغییر برای تابع با زمینھ منوی: تنھا عمودی خط روی بر کلیک با

) غیره و توضیحات، افست، فاکتور،( واحد سریعا تا کنید یککل نقشھ بالای چپ سمت گوشھ یا توصیف محدوده در: نقشھ فقط
  .دھید تغییر را نقشھ داده یا محور

  

  :2d' ' نمایش حالت

  .شود می ظاھر زوم فاکتور تغییر برای تابع با زمینھ منوی یک: افقی یا عمودی مقیاس روی بر کلیک با

  

  ":نقشھ انتخاب" پنجره

  .شود می ظاھر ھا پنجره حذف و مقابلھ شدن، بستھ باز، عملکردھای با زمینھ منوی یک: کنید کلیک نقشھ یا پروژه یک روی بر
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  )Selections( ھا انتخاب

  :مبانی

 و است آسان بسیار این. کنید انتخاب را آنھا باید ابتدا دھید، تغییر بار یک در را مختلف ھای داده فیلدھای خواھید می شما اگر
 موس و داده فشار را دکمھ ،)ماوس چپ سمت دکمھ با( کنید کلیک جایی روی: کند می کار دیگر دوزوین برنامھ ھر مثل درست

  اید کرده انتخاب شما. دھید حرکت را

  .دارد وجود ترفندھا از برخی اما

  :انتخاب حالت

WinOLS حالت توانید می شما کنید امتحان را آنھا فقط. ستون یا ردیف مستطیل، متوالی،: کند انتخاب مختلف سبک ۴ با تواند می 

 نوار اگر ابزار نوار در شاید و پنجره فرض پیش منوی در ،"انتخاب حالت" / "انتخاب" منوی در حاضر حال در شده انتخاب
  .است فعال فعال" انتخاب"

 معمول طور بھ را انتخاب کار، این انجام برای. کنید انتخاب بعدا توانید می اید، کرده انتخاب را اشتباه حالت انتخاب اگر: ترفند
  .کرد خواھد تغییر جدید حالت بھ انتخاب. دھید تغییر را انتخاب حالت آن از پس بلافاصلھ و دھید انجام

  .کنید انتخاب آدرس ستون روی بر کلیک با را ردیف توانید می شما متن حالت در: ترفند

  

  :پیکربندی

 و گفت در تواند می حاضر حال در انتخاب روش. کنید کار مختلف تحال دو در WinOLS با است ممکن شما انتخاب، مورد در

  .شود دیده »نما مکان حرکت ھنگام انتخاب حذف« در «Miscellaneous« برگھ در پیکربندی گو

  

 بسیاری در روش این. شوند می ناپدید بلافاصلھ ھا انتخاب کنید، عوض را نما مکان موقعیت اگر شود، فعال باکس چک این اگر
 خواھید می اگر. باشد تر مشکل کمی چندگانھ اصطلاح بھ ھای انتخاب شود می باعث این اما. شود می انجام ویندوز ھای برنامھ از

  .دارید نگھ و داده فشار را Ctrl کلید باید کنید، اضافھ فعلی انتخاب بھ را دیگر بلوک یک

 را چیز ھمھ خواھید می اگر. دھید گسترش را فعلی انتخاب تا کنید انتخاب دوباره سادگی بھ توانید می باشد، نشده فعال جعبھ اگر
  .کنید استفاده Delete کلید از فقط کنید، انتخاب

  :ویژه موارد

 انتخاب یا کرده انتخاب را مشاھده قابل ھای سلول ھمھ دھند می اجازه شما بھ آنھا. دارد وجود »انتخاب« منوی در خاصی موارد
  .کنید معکوس را

  :دبور کلیپ

 بھ است ممکن حتی کوچک ھای انتخاب. کنید گذاری جای جایی را آن و کرده کپی را فعلی انتخاب توانید می شما معمول، طبق
  .شوند وارد جستجو پنجره در جستجو پنجره عنوان

  :ذخیره و بارگیری

 را "blk" ھای فایل این. کنید اریبارگذ دوباره بعدا را آنھا و کنید ذخیره را خود دیسک ھارد روی بر انتخاب است ممکن شما

 می کنید، بارگذاری را انتخاب یک خواھید می اگر. کرد خواھید پیدا »انتخاب« منوی در را لازم دستورات شما. کند می ایجاد
  .کنید رھا و بکشید WinOLS بھ را آن توانید
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  ) Elements( عناصر

  :مبانی

 چیز ھمھ امروز. کند اداره را داده محدوده یک تواند می تنھا WinOLS. شتدا وجود eprom یک با ECU یک تنھا گذشتھ در

 دلیل ھمین بھ. باشد داشتھ غیره و eeprom پردازنده، ،eprom چند در را اطلاعات تواند می ECU یک است کرده تغییر

WinOLS در. کند اداره را مختلف ھای داده ھای محدوده این تواند می اکنون ھم WinOLS شود می نامیده" عناصر" آنھا.  

 از مثال عنوان بھ افزار، سخت یک از ھا داده حاوی عنصر ھر. باشد داشتھ) یک حداقل اما( عنصر ٨ تا تواند می پروژه یک
eprom  

  :عناصر مشاھده

: دھید تشخیص را پنجره WinOLS عنوان از توانید می شما. دھد می نشان را eprom عنصر WinOLS فرض پیش طور بھ

"WinOLS - 1134.ols (Original) موتور عنوان بھ  /Eprom". نقشھ و( ھا نقشھ شامل فقط نقشھ لیست باشد، فعال عنصر اگر 

 فعلی عنصر از خارج در را ھا داده جستجوی تابع یا »تفاوت« پنجره مانند دیگر توابع. دارند قرار عنصر این در کھ است) بالقوه
 و) باینری صادرات مثال عنوان بھ( کنند می پشتیبانی را عنصر یک فقط کھ صادراتی وابعت مثل درست. گیرند می نادیده نیز

  .کنند می صادر را فعلی عنصر فقط بنابراین

 eprom عنصر یک توانید می شما بنابراین،. شوند می شروع ٠ آدرس با عناصر تمام فرض پیش طور بھ: باشید داشتھ توجھ لطفا

  است مختلف محتویات با مختلف ھای نقشھ این وجود این با. باشید داشتھ ٠ آدرس در CPU صرعن در نقشھ یک و ٠ آدرس در

  :فعلی عنصر تغییر

 آن روی اگر .(«Navigation« نماد نوار در سبز P( دید خواھید «Properties: Project« دکمھ کنار سیاه کوچکی مثلث یک

 آن تا کنید کلیک دلخواه عنصر روی بر. است شامل پروژه کھ عناصر تمام نمایش شد، خواھد باز کوچک منوی یک کنید، کلیک
  .کنید فعال را

  

  

  

  

  

 ھمان بھ برای پروژه خواص در "ECU از استفاده" تغییر) چندگانھ عناصر شامل پروژه اگر( است ممکن ھمچنین شما عوض در

  .اثر

  >:عناصر ھمھ<

 طولانی hexdump یک در زمان، یک در را عناصر تمام این .است>" عناصر ھمھ"< ورودی یک شامل نیز عناصر با لیست

 ھایی نقشھ شامل عنصر کدام نیستید مطمئن شما اگر یا و عناصر تعریف خواھید می شما اگر باشد مفید تواند می این. دھد می نشان
  .ھستید آن دنبال شما کھ

  :عناصر تعریف و ویرایش

WinOLS یک خواندن ھنگام را عناصر خودکار طور بھ ECU فایل یک از کردن وارد یا BdmToGo می اگر. کند می ایجاد 

 برای کمک. کنید کلیک ECU از استفاده کنار در"..."  دکمھ روی و کنید باز را پروژه خواص دھید، تغییر را تعریف این خواھید

  .دھد می توضیح را جزئیات" پروژه در چندگانھ عناصر" گو و گفت این

  :ھا ھنسخ مقابل در عناصر

 اندازه، شماره،( عناصر تعاریف پروژه یک ھای نسخھ ھمھ برای. باشد نسخھ تعداد ھر و عنصر ٨ شامل تواند می پروژه یک
. باشد متفاوت ١ نسخھ در eprom عنصر از تواند نمی اصل در eprom عنصر یک مثال، برای بنابراین،. ھستند یکسان) منطقھ

  .شود می اعمال پروژه عناصر ھمھ برای ھمیشھ تغییر این دھید، تغییر را فعلی نسخھ شما اگر
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  ) Clients(  مشتریان

  :مبانی

 پروژه، تابع عملکرد بر این. کنید حرکت eprom پرونده داده ھای پرونده بین سرعت بھ کھ دھند می را امکان این شما بھ مشتریان

 آسان خود ھای پروژه کردن مرتب برای را شما مشتریان. گذارد می تاثیر جدید ھای پروژه ایجاد و مشابھ ھای پروژه جستجوی
  :برای مثال برای کنید، ایجاد ھا پوشھ توانید می ترتیب این بھ. کند می تر

  اصلی مشتریان ·

  قدیمی ھای پروژه ·

  کارکنان ·

  ناتمام/  شده تکمیل ھای پروژه ·

  :مشتریان ایجاد 

 مشتریان بھ را خود نام توانید می ھمچنین شما. کنید پیکربندی) مسیر زیر( ندیپیکرب در خود صفحھ در را مشتریان توانید می شما
  .کنید مدیریت را آنھا تا دھید اختصاص خود

  :فعلی مشتری تغییر

 می امکان شما بھ کھ کنید پیدا »باز پروژه« کادر در و «Navigation« ابزار نوار در را) کلاه( مشتری آیکون توانید می شما

  .دھید تغییر شده تنظیم قبل از ریانمشت بین دھد

  :عواقب

 در آنھا. ھستند نامرئی WinOLS فایل توابع برای) دارند اقامت خود پوشھ در و( ندارند تعلق فعلی مشتری بھ کھ ھایی پروژه

" ھا هپروژ رسانی روز بھ" یا و" مشابھ ھای پروژه جستجوی" مانند ھایی عملکرد برای و شوند نمی ظاھر ھا پروژه فھرست
  .شود نمی استفاده

  

 داده مسیر بھ ھمچنان و ماند می باقی خود قدیمی مشتری با کند می تغییر مشتری وقتی ھستند شدن باز حال در کھ ھایی پروژه
 اشاره »مشابھ ھای پروژه جستجو« مانند فایل توابع برای) خودشان نھ و( فعلی داده مسیر بھ ھمچنین آنھا اما. شود می ذخیره خود

 کردن باز« کادر در و کرده راست کلیک آن روی دیگر، گیرنده سرویس یک بھ موجود پروژه یک جابجایی برای. کنند یم
  .کنید کلیک »پروژه

  

  

 ایجاد فعلی مشتری برای ھمیشھ پروژه این ،)کردن رھا و کشیدن با یا New منو آیتم طریق از( کنید ایجاد جدید پروژه یک اگر

  .شود می
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  ) Reseller(  فروش ایندگینم

  :مبانی

Reseller کاربران بھ دادن اجازه برای روش یک WinOLS انتشار برای. است کاربران دیگر بھ ھا پروژه فروش یا انتقال در 

 ندهنمای توسط باید فقط شما فروشندگان، از اطلاعات دریافت برای. کنید نام ثبت EVC در مجاز نماینده عنوان بھ باید ھا، پروژه

 ای گزینھ آن از پس). کنید استفاده WinOLS رسانی بروز عملکرد از سپس و( شوید پذیرفتھ مشتری عنوان بھ شده ثبت فروش

-کلاه( مشتری یک عنوان بھ را آن اگر عنوان بھ فروش نماینده ھای داده بھ دسترسی برای" کردن باز" گفتگوی از استفاده برای
  .است شده ذخیره) آیکون

  

  :وام

 نماینده اما است، فرض پیش طور بھ اعتبار ١٠ ھزینھ پروژه ھر. است اعتبار مشتری، و فروشنده بین صورتحساب برای ایھپ
 برای جداگانھ حساب یک. کند استفاده) ٠ جملھ از( دیگری مقدار کردن وارد برای پروژه خواص محاوره از است ممکن فروش

  .کرد مذاکره مشتری و فروشنده بین توان می را واقعی ارزش. شود می حفظ مشتری/  فروش نماینده از یک ھر

    

  

  :فروش نمایندگی

 عنوان بھ بعد، دفعھ در رسانی روز بھ کارکرد بھ شروع شما کھ ھنگامی نام، ثبت از پس بگیرید تماس EVC با تماس برای لطفا

 تمامی WinOLS. شد خواھد ایجاد) فایل ستمسی در مربوطھ پوشھ یک با( ویژه سرویس یک. شوید می پیکربندی مجرب نماینده

  .کرد خواھد ذخیره دارید می نگھ EVC سرور در اینجا در کھ را ھایی پروژه
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  ) Special Aspectsویژه ( ھای جنبھ

  کلید صفحھ میانبرھای

WinOLS در و کشویی منوی در تابع کنار در مستقیما آنھا اکثر. کند می پشتیبانی توابع از بسیاری برای میانبر ھای کلید از 

Tooltip اند نشده ذکر لیست در زیر میانبر ھای کلید. ھستند مستند آن آیکون:  

   )Cursor + Navigation  ( ناوبری+  نما مکان

        

Scroll Lock  :طریق از توانید می راحتی بھ حالت این در اسکرول حالت تغییر hexdumps حرکت ماوس چپ سمت دکمھ با 

  .کنید

 Ctrl+Up      : برد می بالا را رویت قابل منطقھ  

Ctrl+Down  : دھد می حرکت را پایین رویت قابل منطقھ  

 Ctrl+Top  : برد می پنجره ابتدای بھ را نما مکان  

 Ctrl + End  : دھد می حرکت پنجره انتھای بھ را نما مکان  

  Shift + Cursorkeys  :کند می انتخاب حرکت حین در و دھد می حرکت را نما مکان  

 Ctrl + Cursor l / r  : یک شروع آدرس hexdump دھد می حرکت را  

 Ctrl + Shift + Cursor l / r  :٣ حالت فقط( چرخاند می را نمایشd)  

 T  : قبلی مشاھده حالت (3d -> 2d; 2d -> Text)  

 Shift + T  : بعدی مشاھده حالت (Text -> 2d; 2d -> 3d)  

  Ctrl+PageUp  :تنظیم قابل پرش اندازه با( بالا صفحھ(  

 Ctrl + PageDown :تنظیم قابل پرش اندازه با( پایین صفحھ(  

    

  Alt، Shift، Ctrl با ویژه موارد

Shift شروع ھنگام در OLS  :  WinOLS شود می باز قبلی ھای پنجره بارگذاری بدون.  

 Ctrl شروع ھنگام در OLS  :شود نمی استفاده/  اولیھ صورت بھ ساز شبیھ وضعیت نمایش  

 Shift + Mousewheel  :کند می عبور صفحات از خطوط جای بھ  

 Shift شود می سرکوب خودکار نقشھ تشخیص  : نقشھ یک ایجاد ھنگام در  

 Strg + Mousewheel  :تنظیم zoomfactor / fontsize  

 Ctrl + Shift + Mousewheel : کند می حرکت یافتھ تغییر ھای سلول روی بر نما مکان  

    

  ماوس توابع

  کند می تنظیم را نما مکان موقعیت:  چپ کلیک

 Left: Click+Drag  : کند می انتخاب را منطقھ یک  

Left: Click+Drag+Ctrl  : دھد می گسترش دیگر منطقھ یک با را فعلی انتخاب  
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  شود می باز 'Properties: Window' منوی:  کنید کلیک دوبار: چپ 

  کند می باز را" آدرس بھ رفتن" منوی:   متن hexdump در آدرس ستون روی بر کلیک دوبار: چپ

     

  )Middle(میانھ 

 Click+Mousewheel : دھد می تغییر را انتخاب انتخاب، در نما مکان موقعیت بھ بستھ  

 Click+Mousewheel+ Shift  تر قوی اما بالا، در کھ ھمانطور  

    

  کند می باز را زمینھ منوی:  ( Right: Click ) راست کلیک
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